Readability, Grammar, and Vocabulary-Profiling of Content for a Sound Production Course Taught with Free Courseware

Everette Busbee
(Jeonju University)


Content course English should be comprehensible but challenging. Textbooks using such English are rare for lower language levels, so content courses often require teacher-generated materials. A quick Internet search may locate authentic materials that seem simple enough, but an analysis can validate this while assuring materials are challenging enough to offset the content teacher’s tendency to rely on language students already know. This paper describes matching the materials and student levels for a sound production course. A student project was broken into tasks, and sections of online files covering those tasks were graded by readability software. Promising material was then run through concordance software to determine the frequency of target forms and highlight repetitive grammar. Finally, vocabulary software provided lists of basic, academic, and off-list words. Each student required a package of software, but commercial wares would have been prohibitively expensive. The solution, which the author has never seen in print, was lesser-known but high-quality freeware. A course syllabus was produced by simply listing software and associated tasks in logical teaching order. Teaching is described and software and materials sources are provided, so an English teacher with computer skills could teach this class without demanding preparation. Principles of course design and software acquisition described here can be applied to other subjects.

I.  INTRODUCTION

Although the term ‘content course’ has been applied to just about any type of EFL/ESL course not based on dialogs, the author offers this definition: It is a course that rigorously teaches demanding subject matter in an L2 while manipulating, primarily behind the scenes, classroom spoken and written language so as to improve comprehension, thereby
increasing language learning. The goal of a content course is, then, dual: mastering an intellectual subject while improving language skills. This requires stimulating content and challenging language that is, after sufficient classroom work, ultimately understandable. Commercially produced content course materials, which is to say textbooks, at an advanced language level are at times available, but this is not the case for the lower language levels (Kasper, 2000a). Johns (1990) says emphatically that such materials simply do not exist. Myers (2000) states that teacher-prepared materials are essential to fill this gap, but her only effort toward this was the production of audiotapes for student practice in listening. Busbee (2004), reporting on a server configuration class for computer majors at a low English level who were preparing for long-term study in India, responded to the lack of appropriate content by creating a body of material from a large number of small selections from a single massive online manual, but he did not analyze those materials for language level.

Given that appropriate materials at the lower language levels do not exist as commercial textbooks, candidate materials for a course must be located, with the prime source being the eminently searchable Internet. Ideally, this is only the first step. After a teacher amasses a body of authentic material that appears from a visual scan to be at the appropriate language level, a more scientific analysis of the language level can lead to wiser choices as to which sections or paragraphs to include in the final materials, a process the author has not seen mentioned in print. To be practicable, the analytical process should be simple and quick, which requires that candidate materials be digital files, a condition met by Internet files.

The choice of language level concerns a more subtle issue than that of comprehension, it concerns the ways teachers deal with comprehension, which can strongly affect course outcome. Materials written in English at too high a level often force content teachers to focus on language at the expense of content, so that little content is learned (Freeman & Freeman, 1998). Stoller (2002) refers to this as using content merely as a conduit for teaching language.

On the other hand, language analysis during materials selection can assure the level is high enough to counter a tendency described by Swain (1988), based on his study of a large immersion content program: Without a conscious decision to do so, but quite understandably, content teachers often settle on classroom language that consists primarily of forms students already know, so as to increase comprehension of content. The result in this case is that little language is learned. A rational inclusion of more demanding grammar forms in the materials selection stage would provide an impetus for a content teacher to use more adventurous classroom English, and this would be especially likely if materials are teacher generated.

The question then becomes, and this is the first of the four practical questions of this
paper, in what specific way can simple, quick language analyses be carried out on online files that have been determined to contain the desired information for a class? In answer, this paper reports on simple but effective analyses with uncomplicated software to 1) determine the US school grade level of materials, 2) provide concordances that can be scanned visually for both difficult syntax and appropriate forms to focus on, and 3) list vocabulary by level.

The second question this paper addresses is an issue most teachers of computer-centered technical content course face if their subject matter is not covered by software that happens to be installed on computers in their labs: how to acquire the quality software required by their subject, for an entire computer lab in an era of shrinking budgets. This paper, based on a computerized sound production course that the author has designed and taught, gives one, and perhaps the only, solution: the use of a number of smaller open source and freeware programs that together form a ‘suite’ that can rival commercial wares in functionality.

The third question is how to quickly produce a good syllabus. A by-product of the selection of classroom tasks and the software to perform them is that a coherent syllabus arises from simply listing the programs (and their associated processes) in the natural, that is, logical order in which they should be taught to allow a project to be carried out. A coherent syllabus with tight internal logic, especially one produced with such ease, is a valuable commodity in the field of content teaching, where, as Eskey (1997) has pointed out, teaching methodology has received a great deal of attention, but the content syllabus has not.

A good syllabus, however, comes to life only via appropriate methodology, for as Bruton (2007) notes, a content syllabus is not automatically communicative, “it is only the type of interaction in the classroom that will make the syllabus communicative” (p. 229). How to teach the class communicatively becomes the fourth and final question of this paper. In answer, details for teaching the course are provided, including examples of written materials and transcripts of sample lectures. This, along with the syllabus and a list of Internet sources for software and materials that usually have easily-found up-to-date substitutes, can serve as a practical course guide. The subject matter, while technical enough to require students to process considerable English for content, is nevertheless of the general sort that any mp3 enthusiast can master, regardless of education level or college major. Similarly, any English teacher with moderate computer skills should be able to teach it without overly demanding preparation. For an English teacher wary of teaching computers, it should be noted that the term “technical content course” includes such courses as a hands-on class in cooking techniques described by Takagaki and Tanabe (2007).

The literature review focuses on 1) definitions of ‘content course’ and the related issue
of appropriate content, 2) how computers and technology fit into content courses, 3) listening as it relates to lectures, and 4) readability formulas. Next the use of cost-free language-analysis software is explained. Then comes a description of the student software lying at the heart of this course, including its choice, cost-free acquisition, and basis as a course syllabus. Next is a look at the students, class and general teaching methods. This is followed by a lengthy description of lectures and handouts and their use. Finally, some conclusions are drawn.

II. REVIEW OF THE LITERATURE

1. Content Course and Content: Problematical Terms

1) What Qualifies as a Content Course?

There is general agreement that a content course requires Content Based Instruction (CBI) as its primary methodology. However, the consensus concerning content courses seems to end there, for the term “content course” has been applied to every type of EFL/ESL course not based on a simple conversation textbook designed around dialogs. Haynes (2000) uses the term for a course in which students read *The Old Man and the Sea* and then discuss it and write about it. Kasper and Singer (2001) describe a content course that consists of multiple viewings of a silent film followed by writing and discussion. Even formal definitions of “content course,” as in the following two by leaders in the field, are of little help. The first definition, by Kasper (1998a), is that a content-based course is one in which ESL students use English to expand their existing knowledge bases. In simple English, this means that ESL content course students learn something new with English as the medium. The second definition, by Pally (2000b), is that a content course is one in which students practice English language skills while studying a topic. These definitions are so broad as to include every reading class and every discussion and writing class with an assigned topic.

Woodman (2000), in a review of Brinton and Master’s (1997) collection of articles on content teaching, noted similar vagueness. The reviewer stated that the editors explicitly defined content-based instruction so broadly that many of the lesson plans offered were just standard ESL activities, such as watching a music video and then transcribing the lyrics and discussing them. This lack of clarity in defining a content course seems to filter down and affect the clarity with which concrete class topics are described: Woodman (2000) noted that topics suggested by Brinton and Masters (1997) are often so general as to be of no practical value to a classroom teacher.
It becomes obvious that a clear definition of “Content Course” requires clarity concerning the nature of appropriate content.

2) Appropriate Content: At the Heart of Defining Content Course

Because subject matter merely provides input for students to process for meaning, theory states that subject matter is of no consequence as far as language learning is concerned, an issue reviewed by Busbee (1998) and Busbee (2000). However, as a practical matter, some subject must be chosen, and it is intuitive that all subjects are not equal.

Here teachers are on their own, because the literature offers little assistance for the content syllabus (Eskey, 1997), except for such soft content as a student’s family or hobbies. Kasper (1998a) emphasizes the need for a variety of topics, which is illustrated by the breadth of the content of her textbook on Content-Based Instruction, Interdisciplinary English (Kasper, 1998b): Ten disciplines are offered, each with three short readings. Each reading is provided with key vocabulary, comprehension exercises, and discussion and writing suggestions. The topics tend to be the sort of material common in ESL readers and writing textbooks for the past 30 or more years. The section on mathematics contains a reading on the mathematical brain, the section on psychology one on sleep and dreaming, the section on environment science one on earthquakes, and the section on computer science one on the millennium bug. This is soft science. Pally (2000a) relates a student’s complaint about content course writing topics sometimes being so simple that everything written is guaranteed to succeed.

Some researchers demand far more rigor from content and so exclude soft topics. Met (1999) limits content to cognitively engaging and demanding material, while Chaput (1993) limits content to topics of intellectual substance. The author would suggest that content have enough intellectual weight to 1) provide, as a single coherent subject, material for an entire school term, 2) require the same rigorous instruction as in a mainstream class, 3) engender the respect of students, and 4) play some meaningful part in the students’ overall education other than in language improvement. An EFL/ESL course teaching this kind of content via CBI is, then, a content course.

The classic example of this is the psychology course at the University of Ottawa taught to English speakers in French (Edwards, Wesche, Krashen, Clement, & Kruidenier, 1984). A test on content showed that its students matched the test scores of students completing the corresponding mainstream course. Baker (1993) indicates the rigor possible in content courses, based on his observation of content teaching in a foreign language at the Monterey Institute of International Studies: The teachers, he writes “are not interested in content-based language instruction; they are simply interested in ‘content’” (p. 122).
This kind of rigor requires classroom language to be largely comprehensible. Consequently, many teachers would exclude as a content course any course in which students are expected to get only the ‘gist’ of a short story or the ‘feeling’ of a poem. Given that literature classes can be quite difficult for native speakers, the rigor of an EFL/ESL content course based on literature would of necessity be far less than the rigor of, say, the University of Ottawa psychology course. This would be especially true if the literature course is used, as Kasper (2000a) suggests, to introduce EFL/ESL students to academic English. The author’s experience is that English learners at lower levels struggle with both sentence-level meaning and broad meaning in short stories. Literature deals with language less directly and more artistically, and its vocabulary is broad indeed. A rigorous treatment of literature is appropriate only for the genuinely advanced student.

Literature as content may also ignore practical issues in EFL/ESL students’ lives. Standardized tests are oriented toward nonfiction (Dreher, 1998; Parkes, 2001), so students whose reading consists largely of literary material may not do well on such tests (Snow, 2002). In addition, the purpose of much of the L2 reading of students later in their lives will be to acquire information rather than enjoy literature (Hoyt, Mooney, & Parkes, 2003).

Choosing materials for their comprehensibility is largely embedded in the choice of a course subject. That is, the English of certain subjects is better suited as content than others. The best subjects for the intermediate level and below involve straightforward language with a manageable vocabulary, which describes much of the language of technical fields that use computers (Busbee, 2004). However, such language could just as easily be the medium for the hands-on home economics content course in cooking techniques described by Takagaki & Tanabe (2007).

There are many possible semester-length subjects other than literature with an honorable mainstream history of academic rigor, subjects not unduly technical for English teachers, such as art history, which it must be remembered would be for EFL students, not art majors.

2. Computers and Technology in Content Courses

Computers and technology are often associated with content courses, either as content or the context in which content is handled. Computers may even be explicitly presented as both content and context, as when learning how to send email while at the same time focusing on email content (Egbert, 2000). However, computers and technology in EFL/ESL courses rarely goes beyond the three standard subjects listed by Vitanova (2000): computers for writing, for running multimedia software, and for using the Internet, including email. This is seen in Kasper’s (2000a) graduate-level textbook *Content-Based College ESL Instruction*. One of the book’s three sections, entitled *Incorporating*
Technology into Content-Based Instruction, has four papers. Two deal with email interchanges (Egbert, 2000; Tyllyer & Wood, 2000), and one deals with the Internet as a source of materials (Kasper, 2000b).

This emphasis on email and the Internet as content is problematic. First, it is stretching the term ‘content course’ beyond recognition for Kasper (2000a) to include simple email exchanges as two chapters in her textbook on college ESL content instruction. Second, her view (Kasper 2000a), restated in Kasper (2003), that the Internet is a good source of content ignores the extremely advanced nature of English written by native speakers for native speakers. Busbee’s (2001b) review paper concluded that the Internet’s content was overwhelmingly inappropriate for low-to-intermediate EFL students. (Although this sound production course drew its materials from the Internet, the subject uses particularly simple English, and even then the material was thoroughly sifted to assure further simplicity.) Third, Kasper (2000a, 2003) suggested training in the use of the Internet as content. This view is now dated: the fluency of today’s college freshmen in using the Internet is a given. To retain relevance, computer use in content courses needs to be updated from a simple reliance on the Internet. This is the broad goal of the Sound Production for English Teachers content course described in this paper.

3. The Treatment of Listening by Content Teachers

The attitude of many English teachers toward listening is illustrated by Kasper (2000a). She notes that few content materials address listening, with listening materials referring to audiotapes or CDs. Myers (2000) likewise addresses listening in her content course by making her own tapes. For EFL/ESL classes, the general outlook is that listening involves recorded material for use outside of class, and class time is for students to participate in discussions. Even in these classes, English spoken by native speakers tends to be rare. Marcia Pally is a brilliant writer and dynamic speaker, yet transcripts of her content courses show that she speaks hardly at all during class discussions (Pally, 2000c). With English teaching’s stress on students speaking rather than teachers, lecturing in ESL classes seems almost taboo, which ignores the central position of lectures in mainstream undergraduate academics.

A content course that neglects lecturing may not meet student needs. Snow and Brinton (1988) conducted a follow-up survey of mainstreamed ESL students a year after they completed an ESL course aimed at preparing them for the mainstream. Students were asked to rank the usefulness of 13 academic skills taught in the course, and note-taking skills were ranked highest: These students strongly desired to master lecture material. Ranked last for academic usefulness was giving oral presentations, which is often valued by ESL instructors. Student perceptions of the importance of lectures match those of
university faculty, who view listening and reading skills as more important than speaking and writing (Johns, 1981). Mason (1995) has stressed the importance of aural skills in the academic mainstream, and Ferris and Tagg (1996) even suggest that English for Academic Purposes (EAP) classes invite guest lecturers to give students listening experience.

4. The Validity of Readability Formulas

As Hayes, Wolfer, and Wolfe (1988, p. 493) put it, “Text difficulty is a complex, multidimensional concept, and much is not yet understood.” An indication of the extent of the problem is Fatt’s (1991) assertion that some 150 linguistic variables correlate with reading difficulty. Reading researchers have long responded to this complexity by devising many tests to measure the difficulty of a text, with the number of readability tests reaching over 200 some three decades ago (Harrison & Gardner, 1977). In spite of the complexity of reading, for readability tests to be of practical value before the computer age, they had to be easy to apply, so reading level tests came to rely on just two simple indicators in a small sample. One was some aspect of word length, such as the frequency of polysyllabic words (which correlates with vocabulary difficulty), and the other was sentence length (which correlates with the difficulty of syntax). Given the power of today’s computers, simple formulas are no longer required, but it has been found that complex formulas using additional reading sample measurements do not improve the predictive value of readability tests (Zakaluk & Samuels, 1988). Consequently, the common tests in use today are still based on word and sentence length. These include Frequency of Gobbledygook (FOG) (Gunning, 1952), Simple Measure of Gobbledygook (SMOG) (McLaughlin, 1969), and the Flesch-Kincaid Grade Level Test (Kincaid, Fishburne, Rogers, & Chissom, 1975).

The Flesch-Kincaid Test rates text on a US school level, so that a score of 8.0 indicates a typical eighth grader can comprehend the document without difficulty. The formula for the Flesch-Kincaid Grade Level score is:

\[
\text{FLESCH-KINCAID} = \frac{0.39 \times \text{ASL}}{11.8} + 15.59,
\]

where ASL = average sentence length in words, and ASW = average number of syllables per word.

The validity of word length as a criterion for readability is questioned. For example, the English prepositions, though often only two letters, can cause considerable problems for even native speakers (MacGregor, 1993; Rastall, 1994), due to their multiple meanings that become clear only in context (Smith, 1994). This would be especially true for Korean English learners. Another major concern is that readability tests ignore reader interest (Rayner & Pollatsek, 1989), motivation (Friedman, 1997), and background knowledge.
(Kintsch, 1998), three powerful determiners of reading comprehension. Schriver (2000) faults readability formulas for their inability to reflect cohesiveness and for their basic unreliability. Carrell (1987, p. 35) points out that the formulas ignore “coherence, cohesiveness, the flow of topics and comments, and propositional density.” Agnihotri and Khanna (1992, p. 282) call for a test that focuses on “conceptual difficulty and organization.” Finally, it is obvious that the formulas do not determine whether a sample is well written or even logical. However, Fry (2000) concludes that although the formulas are maligned, they are still valid, and Oakland and Lane (2004) defend the formulas based on their usefulness.

III. SOFTWARE

1. Language Analysis Software and Its Use

Three types of software were used to analyze materials for appropriateness. As with the classroom software, these were available without cost as 1) an applet in the near-universally installed Microsoft Word (readability test), 2) freeware (concordance program), and 3) a free online service (vocabulary profiler). All materials under consideration for handouts, whether tutorials, manuals, or online help files, were first converted into text files and then run through the Flesch-Kincaid applet. Those files determined to be at an appropriate reading level were then run through the concordance software. The files with both good content and repeating forms were then run through the vocabulary profiler. In only two cases was a file discarded for overly demanding vocabulary, so the profiler served mainly as a teaching aid for listing vocabulary by level of difficulty, not as a tool for materials selection.

1) Readability

Software: Flesch-Kincaid applet (Included in MS Word)
Source: Microsoft Word

Commercial software for grading readability is common, but the only free program is an applet in Microsoft Word. The applet provides a reading level using the Flesch-Kincaid formula. This option must first be activated by clicking Tools ➤ Options ➤ Spelling & Grammar and checking Show readability statistics. Then, after the text is spell and grammar checked, the Flesch-Kincaid score is given. A shortcoming of the MS Word readability score is that while the Flesch-Kincaid formula provides scores up to 20, the
Ph.D. level, MS Word gives a maximum score of 12. In practice, however, this presents little problem, because it is generally accepted that writing scored at 12 is too complex even for many native speakers.

The later section on teaching will present several class handouts at an appropriate readability level, so here two examples of rejected text are given. The first sample comes from the Audacity online help files, which was the source of several useful handouts. Its Flesch-Kincaid grade level score is MS Word’s maximum, 12. In addition to its advanced vocabulary and syntax, its concepts are dense: vibrating membranes, electrical mechanisms, acoustical and electrical waves, high pressure corresponding to high voltage, waveform translation, electrical and magnetic signals, and a reversal of the process.

A microphone consists of a small membrane that is free to vibrate, along with a mechanism that translates movements of the membrane into electrical signals. (The exact electrical mechanism varies depending on the type of microphone.) So acoustical waves are translated into electrical waves by the microphone. Typically, higher pressure corresponds to higher voltage, and vice versa. A tape recorder translates the waveform yet again, this time from an electrical signal on a wire, to a magnetic signal on a tape. When you play a tape, the process gets performed in reverse, with the magnetic signal transforming into an electrical signal, and the electrical signal causing a speaker to vibrate, usually using an electromagnet.

(From “How is sound recorded?” in Audacity’s online help)

Flesch-Kincaid grade level: 12.0

The next sample, with a Flesch-Kincaid grade level of 2.5, is an example of English that is too simple. Although such material may be appropriate early in the course, when confidence is being built, it offers little in the way of language learning for intermediate students.

Open the MP3 file. Select the part of it that you want to be the first file. Listen to it by clicking the Play button. While this part is selected, choose Export as MP3 from the File menu. Now select the part for the other song. Export again.

(http://wwwlb.aub.edu.lb/~acc/Resources/Teaching/Media/Audacity/Audacity%20Tutorial)

Flesch-Kincaid grade level: 2.5
2) Syntax

Software: ConcApp Concordancing Program (Freeware)  
Alternative Software: Online Concordancer (Free online service)  
Source: http://www.lextutor.ca/concordancers/

There have been attempts to rank the difficulty of syntax structures, as when Bygate (1987) and Anderson and Lynch (1988) concluded that coordinate clauses are more easily comprehended than subordinate clauses. Such attempts have been far from comprehensive. Nevertheless, running a sample through concordance software can give a quick idea of its complexity. For example, a teacher can visually scan a listing of all “if” sentences for a quick estimate of the frequency of difficult conditionals. A concordance has another value: it allows a sample rich in a particular grammar pattern to be selected for instruction that focuses, largely behind the scenes, on form. The following, from the Audacity help file, is part of a printout from a ConcApp concordance that highlighted a useful form.

To select the part you wish to cut, copy or paste, use the selection tool  
To mark an area, press and hold the left mouse button  
To listen to the audio in the marked area, press the space bar  
To extend or contract your selection, hold down the shift key  
To set the right hand boundary of your new selection, click at a spot  
To cut the selection, select Cut from the Edit menu  
To undo this operation, select Undo in the Edit menu

3) Vocabulary

Software: Vocabulary Profiler (Free online service)  
Source: http://www.er.uqam.ca/nobel/r21270/cgi-bin/webfreqs/web_vp.html

Nation (2001) splits vocabulary into four groups, basic words, general academic words, specialized academic words (for a particular field), and low frequency (off-list) words, with all but the last often put into lists. Standard lists are West’s (1953) basic word list and Coxhead’s academic word list (Coxhead, 2000), but the large number of academic technical fields, along with their tendency to overlap, makes useful specialized academic lists difficult to produce (Chung & Nation, 2003).

The free online Vocabulary Profiler splits texts into lists that can be used for choosing
appropriate content as well as for teaching. The text is returned with vocabulary statistics and with words color-coded by list, as shown in the following table. The sample is from Audiograbber’s Basic Guide at http://www.audiograbber.com-us.net/gettingstarted.html.

**TABLE 1**  
WEB Vocabulary Profiler Output*  

<table>
<thead>
<tr>
<th></th>
<th>Families</th>
<th>Types</th>
<th>Tokens</th>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st 500 Words</td>
<td>...</td>
<td>...</td>
<td>(75)</td>
<td>(46.88%)</td>
</tr>
<tr>
<td>1st 1000 Words</td>
<td>56</td>
<td>60</td>
<td>94</td>
<td>58.75%</td>
</tr>
<tr>
<td>Function</td>
<td>...</td>
<td>...</td>
<td>(57)</td>
<td>(35.62%)</td>
</tr>
<tr>
<td>Content</td>
<td>...</td>
<td>...</td>
<td>(37)</td>
<td>(23.12%)</td>
</tr>
<tr>
<td>2nd 1000 Words</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>1.88%</td>
</tr>
<tr>
<td>Academic Words</td>
<td>6</td>
<td>7</td>
<td>12</td>
<td>7.50%</td>
</tr>
<tr>
<td>Off-List Words</td>
<td>?</td>
<td>29</td>
<td>51</td>
<td>31.87%</td>
</tr>
<tr>
<td>65+?</td>
<td>99</td>
<td></td>
<td>160</td>
<td>100%</td>
</tr>
</tbody>
</table>

**Output text: First download Audiograbber Install it by opening agsetup.exe Select a language and click OK You will see a welcoming window Click Next Select a folder to install Audiograbber Click Next and then click Finished Download the LAME encoder from the Audiograbber download page Open it in WinZip Select lame_enc.dll in the WinZip window Click Extract on the toolbar Navigate to the folder where you installed Audiograbber Click Extract again Start Audiograbber Go to MPnumber settings Select LameEnc under internal encoders Now choose your encoding quality I recommend constant bitrate numberkbps*** Joint Stereo High Quality These settings give you MPnumber which sound very much like the original CD You can grab directly to an MPnumber file Proceed to ripping You can enter the names of the tracks Click Grab When ripping is finished all files should be on your hard drive Open your favorite MPnumber player Winamp is a good one Simply add the files to a playlist

*This text, without analysis, is Handout 4, presented later in the section on teaching.

**The Vocabulary Profiler Web site returns submitted text color-coded according to word list. For this paper, font styles were substituted: First 1000 words, regular; second 1000, bold-italics; academic words, bold; off-list words, italic.)

***Vocabulary Profiler changes each number, such as the 3 in MP3, to the word “number,” as in “MPnumber.”

2. General Issues Concerning Software, Including Its Choice and Acquisition

All universities have licensed software, mostly major applications commonly taught in computer courses in the L1. Re-teaching those courses in English would be of little value for language learning, because students already know the material and so would not feel a strong need to process classroom English. Consequently, a content course usually needs software that is not in common use but which has some inherent interest.

Whatever the software, it must not be so simple it can be mastered in a few weeks, nor so complex that more than one semester is needed to complete a project with it. The subject of software level may not be, however, quite so simple. For example, Photoshop
can be taught to novices as a simple photo editor, or to future designers as a professional tool.

A final software issue is acquiring it for every student’s computer. Funding software for a content course is difficult, in that its limited use makes it cost ineffective. The solution is free software, which generally falls into two categories, GNU Open Source Software and freeware. GNU software, often excellent, is normally developed by a programmer or community of programmers who volunteer their labor. Freeware may also be excellent, but it is often commercial software with many features “disabled,” which limits it usefulness.

3. A Suite of Software, and a Framework for a Sound Production Syllabus

This course in sound production involved 1) recording with a microphone to a hard drive, 2) editing to reduce noise, remove unwanted sections, balance and normalize volume, and mix with a musical background or sound effects, 3) compression to produce a file size conducive to Internet use, and 4) coding Web pages so the files could be streamed over the Internet, plus 5) minor file conversions. An Internet search for “audio freeware” found many sites featuring lists of programs dedicated to these tasks. Most programs were shareware, but many were freeware. Software lists may include useful reviews and often display number of downloads per program, an indicator of its performance. In practice, choosing from among similar programs is not critical, because several programs usually perform a task quite well.

Below is a list of the best software the author has come across for sound production, along with sources for downloading. Sources are also given for online manuals, tutorials, and help files for each program. A syllabus with an intrinsic logic was a valuable byproduct of 1) choosing a project and breaking it into clearly defined tasks, 2) matching each task with a program to carry it out, 3) locating for each task explanatory materials from online manuals, tutorials, and help files, and then 4) placing them in the natural teaching order.

Ripping CDs to Hard Drive
Software: Audiograbber (to convert CD audio files into editable digital files)
Source: http://www.audiograbber.com-us.net
Help: http://www.audiograbber.com-us.net/gettingstarted.html

Recording and Editing Sound
Software: Audacity 1.2.6 (editing of .wav files to clean up noise, remove unwanted sections, normalize volume, and mix with a musical background)
Source: http://audacity.sourceforge.net
Help: http://audacity.sourceforge.net/onlinehelp-1.2/reference.html (online help)
Tutorial: http://quicktoots.linuxaudio.org/toots/audacity/. This covers basic editing, gives screen shots, and provides sound files to download for use in tutorials.

Manual: http://audacity.sourceforge.net/help/documentation. This is an excellent zipped manual in HTML format, with screen shots. Sections for new users are good.

Extensive Online Help

Converting Mp3 to Wave Files
Software: MP3 Decode (a utility that allows mp3 files to be converted to editable files)
Source: http://www.etalonsoft.com/mp3decode.html

Encoding (Compressing)Wave to MP3 Files
Software: LAME (high-quality fast MP3 encoder used in conjunction with Audacity)
Source: http://mitiok.cjb.net/

Producing Streaming Media for a Web Site
Software: Helix Producer Basic 9.0.1 Basic (production of streaming audio)
Source: http://www.realnetworks.com
Tutorial: http://cit.cornell.edu/atc/materials/streaming/technologies.shtml

Embedding Sound Files in a Web Page
Software: Any of dozens of free HTML editors, but better yet for this simple process, a simple text editor such as Windows Notepad. This requires some simple HTML coding.

Playback of Sound
Software: Winamp (MP3 player)

IV. TEACHING THE COURSE

1. The Class and Its Students

This sophomore class met two hours a week and fulfilled one semester of a university-wide four-semester computer requirement. Students were English education majors, with better English than the university average. In addition, as freshmen they had taken the author’s major-requirement grammar course, a lecture class taught in English, so many students entered this computer class with considerable hearing skills. The average English level of the class was further enhanced by the tendency of students with lower English
proficiency to choose courses taught in Korean to fulfill computer requirements. This also
contributed to a reasonably small class size, so a computer course taught by the author
typically has about 15 students with fairly good English.

Working in pairs, students completed a project. They chose copyright-free English text
about a page long and recorded it three times, but they could, if they liked, record one of
the university’s native speakers reading it three times. Students then reduced the file’s noise
and eliminated reading errors by copying and pasting good sections into a master file, often
with frequency changes. The file was then mixed with a music background or sound effects.
Finally, the files were prepared for the Internet and then placed on Web pages.

2. General Teaching Methods

The primary sources of information necessary for students to carry out projects were
lectures and handouts distributed over the LAN. Most handouts were covered by lectures,
with questions being an integral part of those lectures. Learning consisted primarily of
students coming to grips with interfaces, menus, and dialog boxes through a mixture of
teacher suggestions and questions, and trial-and-error clicking, which was encouraged.
This process, assisted discovery, leads to a deeper understanding than duplicating a
teacher’s clicking on a large screen, and so is more conducive to long-term remembering.

Typical questions were: “What do you think will happen if you click here?” “To do what
we need to do now, which tool should you select?” “What can you do in this dialog box?”
For questions to be effective, they must be presented well, and students must be trained,
with humor, to deal with them in a way that supports efficient learning. Students were
taught that a teacher’s question was not a signal to watch a miniskirt or some muscles go
down the sidewalk outside while some unfortunate classmate was called on to answer that
question. Instead, a question was asked, 10 or so seconds were allowed for all students to
form an answer, and then one student was called on, with the expectation that the answer
would come immediately. That is, calling on a student was not a signal for the student to
start thinking, but a signal for a student to give an answer that was formulated during the
time allotted for thinking. Students, especially in this small class, adjusted to this system,
although at first it seemed to cause considerable stress, with students saying such things as,
“Professor, please don’t ask so many questions, just tell us what you want us to know.”

Another issue was a two-hour English class involving intense listening. Korean college
students have little experience using spoken or written English as a source of information
to use for anything other than answering test questions, and even readings for tests tend to
be quite short. As a result, sustained instruction in written or spoken English quickly tires
them. Kerans (2001) also saw this in her English content program in Spain, where her
first-term goal was merely for students to develop tolerance for extended listening.
For the first few classes, the author assisted the development of listening tolerance by reading simple introductory material out loud several times, and by lecturing at a slow but phonologically accurate native speaker speed. This introduction also built background (Ulanoff & Pucci, 1999), which is essential for student construction of a coherent overview (Echevarria, Vogt, & Short, 2004). Easier material at first also leads to student success, and success is a powerful motivator (Gage & Berliner, 1992; Cunningham & Cunningham, 2002). A high success rate also indicates that a class is functioning well (Beck & McKeown, 1991).

All students completed their projects, though project quality of course varied. The semester ended with a long and detailed final exam consisting of short-answer questions and short essays about sound production processes. Grading was based solely on the content of answers, not the quality of English. For research purposes, and with much reassurance to the students, the author once attempted to give the final exam as a pretest the first day of class. However, student panic led to near rebellion, and with the prospect of a mass dropping of the class, the pretest was canceled. By the time the semester ended, passing the final exam presented no problem. Content was learned.

For all students, this was the first course ever taken that required information contained in English to be put to work doing something other than answering test questions. In addition, students needed (desired) to comprehend the information being communicated, if for nothing else than to receive a good grade. Processing English for meaning, with a little language assistance, was everything, giving a communicative classroom.

3. The Specifics of Lecturing and Using Handouts

Handouts in this class functioned as reinforcement for material first presented in lectures, as well as sources of new material. In the first case, prior to making a handout available online, the author introduced the material orally as students looked at the open software on their monitors. During lectures, background was built by pointing out the similarity of the software interface to software students already knew, and by comparing computer processes to the process as it was prior to computers, as in editing tape by physically cutting and splicing. One lecture pointed out how Audacity’s tool buttons were similar to buttons on audio players.

The material in Handout 1 was first presented by lecture, then immediately presented again in summary, after which the handout was given to students to read. This handout, taken unedited from the Audacity Web site, has its target form in italics.
Handout 1
Control Toolbar*

Control Toolbar (6 large round buttons at the top) from left to right:

Skip to Start moves the cursor to time 0:00. If you press Play at this point, it will *start playing* from the beginning.

Play starts *playing* audio at the cursor position. If audio is selected, only the selection is played.

Loop is substituted for the Play button if you hold down the Shift key. This lets you *keep playing* the selection over and over again.

Record starts *recording* audio at the project sample rate (the sample rate in the lower-left corner of the window). The new track will *begin recording* at the current cursor position, so click the “Skip to Start” button first if you want the track to *begin playing* at time 0:00.

Pause temporarily *stops recording* or *playing* until you press pause again.

Stop *stops recording* or *playing*.

Skip to End moves the cursor to the end of the last track.

*(From http://audacity.sourceforge.net/onlinehelp-1.2/reference.html. Screen shot by author.)*

Handout 2, an unedited section from the Audacity Help File, focuses on the form *is for*, which showed up in a concordance. While the *is for* pattern may seem too simple, this is an early handout. In addition, the language goal of this course was not the intellectual mastering of forms, as in a grammar class, but the *internalization* of forms so they can be comprehended and produced automatically for communication, a more difficult task.
Handout 2
Editing Tools*

Editing Tools (6 tools on the left of Handout 1) upper left to lower right:
The selection tool is for selecting the range of audio you want to edit or listen to.
The envelope tool is for changing the volume over time.
The draw tool is for modifying individual samples.
The zoom tool is for zooming in and out.
The timeshift tool is for sliding tracks left or right.
The multi tool lets you access all of these tools at once depending on the location of the mouse and the keys you are holding down.
*(From the Audacity Help File.)*

The following lightly edited transcript of the author’s lecture on Handout 2 (the functions of Audacity’s editing tools) illustrates how an initial focus on a form was handled in class, in this case the above is for.

Teacher: A pencil is for writing. A pencil is for writing letters. Or for taking notes. A knife is for cutting, maybe for cutting meat, right? What are some other things for? (Points to a book, then to a desk.)

Students: A book is for reading. A desk is for studying. A desk is for sitting. A desk is for sleeping [laughter].

Teacher: Look at Audacity’s main window. We all know what the selection tool is for, right? In Audacity, it is for selecting a portion of an audio file. And what is the zoom tool for?

Students: For zooming. For zooming closer.

Teacher: Yes, for zooming in to get a closer look at the sound file. That was too easy. Here is a harder one. What is the envelope tool for? Well, the online help file says the envelop tool is for “changing volume over time.” For making it louder or softer, but not suddenly. Well, if we keep decreasing the volume over time, the audio will fade out. Most of you right now are wearing blue jeans. They start out dark blue, but they gradually fade. They get lighter and lighter. When audio gradually gets softer and softer and then disappears, we say it “fades out.” On the other hand, if we start at zero and increase the volume over time, it will fade in. The envelope tool is for fading in or out.

(Teacher continues with all the editing tools, which are far more demanding.)

Background was being built in this lecture, because two of the six editing tools (zoom
and selection) are familiar to just about any college sophomore of today. Students thus acquired something upon which to “hang” the other four tools.

The next handout, Handout 3, was taken unedited from a Web site maintained by the government of the state of South Australia. In the concordance, the form to + verb + object + imperative clause showed up strongly. This was presented to students as “To do A, do B.” (It should be remembered that for selection as handout material, valuable content was necessary before material could be chosen for having a high-density target form.)

### Handout 3
**Cut, Copy, and Paste**

The most basic editing step is cut and paste. It’s what people did with recording tape and it’s easy with data in computers. Let’s take a look at these basic operations, Cut, Copy and Paste.

**To select** the part you wish to cut, copy or paste, **use the selection tool.** If it’s not activated, do so now by clicking on it in the toolbar. Let’s say we want to cut out that bit in the middle then. First we’ve got to select it.

**To mark** an area, **press and hold the left mouse button** while you drag the mouse. This area is darker than the surrounding area of the clip.

**To listen to** the audio in the marked area, **press the space bar**

**To extend or contract** your selection, **hold down the SHIFT button** and click on the area you wish your selection to extend or contract to. [For background building, the teacher reminds students of what they already know by quickly demonstrating in MS Word that this is also true for extending or contracting a text selection.]

**To set the right hand boundary of your new selection,** **click at a spot that is on the right hand side** from the middle of the current selection.

**To cut the selection,** select “Cut” **from the Edit menu** or press CTRL+X. You’ll see:

![Before cutting](image1.png) ![After cutting](image2.png)

**To undo this operation,** select **Undo in the Edit menu or press CTRL+Z.**

Handout 4 illustrates appropriately simple handout material, with a Flesch-Kincaid grade level of 5.6. Although the Vocabulary Profiler analysis of Handout 4 (which was presented in detail earlier, in the section on software analysis) lists 29 off-list “words,” 14 of these are merely names of software or file names. The remaining 15, listed at the end of Handout 4, are technical computer and/or sound terms that range in difficulty from “click” and “install” to “rip,” “grab,” and “bitrate.” According to Nation (2001), these technical computer or sound terms would not in fact be off-list, but would be specialized academic words. Because college students tend to achieve a certain level of computer literacy on their own, and in addition the students in this class have taken two semesters of L1 computer classes as freshmen, these specialized words presented little problem.

**Handout 4**

**Installing and Ripping with Audiograbber***

First, download Audiograbber. Install it by opening agsetup.exe. Select a language and click OK. You’ll see a welcoming window. Click Next. Select a folder to install Audiograbber. Click Next, and then click Finished.

Download the LAME encoder from the Audiograbber download page. Open it in WinZip. Select “lame_enc.dll” in the WinZip window. Click Extract on the toolbar. Navigate to the folder where you installed Audiograbber. Click Extract again.

Start Audiograbber. Go to MP3 settings. Select LameEnc under internal encoders. Now choose your encoding quality. I recommend constant bitrate, 160kbps, Joint Stereo, High Quality. These settings give you MP3’s that sound very much like the original CD. You can grab directly to an MP3 file. Proceed to ripping. You can enter the names of the tracks. Click Grab. When ripping is finished all files should be on your hard drive. Open your favorite MP3 player. Winamp is a good one. Simply add the files to a playlist.

*(From the basic guide http://www.audiograbber.com-us.net/gettingstarted.html)*

Flesch-Kincaid grade level: 5.6, 161 words

Academic word list: (12 tokens, 7 types, 6 families)
Off-list words: (29 types) download, install, click, folder, encode, extract, toolbar, navigate, settings, bitrate, kbps, stereo, grab, rip, playlist.

Handout 5 has a Flesch-Kincaid grade level of 5.7, but it is difficult. Readability scores, as discussed earlier, are by no means perfect. This handout is not only concept dense, the information does not flow well. However, it is information that students needed to know, so the material was covered in a lecture before the handout is given out.
Handout 5
Basic Editing of Tracks*

The label tells you the channel of the track. This can be left, right, mono, or stereo. The sample rate 44000 Hz is the audio CD rate. Beneath that is the quality 32-bit float that is high quality but takes up more disk space. 16-bit is the same quality as an audio CD.

The Mute button stops a track from playing. The Solo button plays only a track (or other solo tracks) and overrides the Mute button. Muting and soloing don’t affect mixing or exporting, just playback within Audacity.

The top slider is the gain control. It affects the relative volume of the track. The bottom slider is the pan control. It affects the balance between the left and right speakers.

*(From audacity.sourceforge.net/onlinehelp-1.2/track_audio.htm)
Flesch-Kincaid grade level: 5.7

A lightly edited transcript of the lecture on Handout 5 is given below.

Teacher: Here we have the main Audacity window. Let’s open a mono wave file. See, there’s one track. Let’s leave that file open and open another one. See, it has two tracks, and it says “stereo” up here on the left. Stereo needs two speakers, one for each track. Even a cheap cassette player usually has two speakers. And of course the mono file says “mono.” “Mono” means one, and it needs only one speaker. Cell phones are mono.

The sample rate is how much data you are collecting when you record. If you sample a lot, the sound quality will be high. If you sample just a little, the quality will be lower. We’ll talk about this later. But for now I’ll say that the important thing here is this: high quality sound is good, but it makes a large file, which is bad. And low quality sound is bad, but it makes a tiny file, which is good.

A person who can’t speak is a mute. You can stop a track from playing by clicking “Mute.” And of course you know solo. All alone, making music. If you click “Solo,” only that track will play. “Solo” and “Mute” are only for letting you hear a particular track during playback. We may need to do that when we want to edit just one track. “Solo” and “Mute” do not change the file. That is important. They do not edit sound at all.

A person who can’t speak is a mute. You can stop a track from playing by clicking “Mute.” And of course you know solo. All alone, making music. If you click “Solo,” only that track will play. “Solo” and “Mute” are only for letting you hear a particular track during playback. We may need to do that when we want to edit just one track. “Solo” and “Mute” do not change the file. That is important. They do not edit sound at all.

The controls that affect the sound tracks are these sliders. We can slide them to the right or left, see? The top slider is the gain control. It is really a kind of volume control that changes the file. The bottom slider is the pan control. We can move the center of stereo sound by adjusting the pan slider. This changes the file, too, so both these sliders are for sound editing. Now let’s go through these again real quick. (Immediate review.)
V. CONCLUSION

A computer content course calls for an interesting project and the software to carry out that project. It might seem that using software already owned by the university, such as word processing or database, would suffice, but the students had already studied those programs as freshmen. At any rate, word processing and database are unlikely to be as interesting as working with microphones and MP3 files. The purchase, however, of commercial software solely for an annual two-hour course in sound would be difficult to justify. This difficulty can be overcome by relying on cost-free applications available on the Internet.

After an interesting project has been decided on and its required software acquired, written content that assists students in mastering the software must be obtained. The lack of a textbook on this software package at the lower English levels (or any level, for that matter) required teacher-produced materials. Materials production can be a mammoth task, so to be practicable, ready-made materials were found among online manuals, tutorials, and help files. Then three simple cost-free analytical tools helped determine which sections, paragraphs, or groups of sentences were at the right level: a test for determining readability level, a concordance program for highlighting grammatical patterns, and a free online service for categorizing vocabulary by level of difficulty. The project tasks chosen, once paired with the software to complete them and materials to learn that software, were then simply listed in the logical order they should be taught in, which in effect gave a solid course syllabus.

The content course described in this paper simulated to a degree what might be taught at a two-year college in the US, complete with reading materials that, although selected for language level and lightly edited, were authentic. However, if this course had duplicated an American course, with no attention paid to the way in which language was presented, it would have ceased to be a content course and become a mainstream course. Sheltering, necessary at the lower language levels, can be provided by an experienced English teacher who is aware of which forms present problems, aware of how to make spoken English more comprehensible by repeating, recasting, gesturing, offering examples, and speaking at a slow native speaker speed without compromised pronunciation. Any English teacher with basic computer skills and some experience teaching in Korea could teach this class, especially if it is remembered that the class will be populated by EFL students, not computer majors. The methods presented for course design, including locating candidate materials, selecting the materials via analysis, producing a syllabus, acquiring student software, and teaching the class, are applicable for any technical content course.
REFERENCES


Applicable levels: Secondary, tertiary, and adult education
Key words: Content course, ESP/EAP, computers

Everette Busbee
Department of English Education
Jeonju University
Hyoja Dong 3ga 1200
Jeonju 560-759, South Korea
Email: busbee@jj.ac.kr

Received in August, 2007
Reviewed in September, 2007
Revised version received in November, 2007